Quick Reference Guide
This guide will help you through the learning curve of the user interface, finding commonly
used features, and becoming familiar with new features you’ll love using.

THE PRO-STITCHER DESIGNER WORKSPACE
Tabs: Select any tab to display
its buttons and functions.

Ribbon: The buttons on the Ribbon change
according to which tab is selected.

Properties box:
Displays and
allows editing
of all
information
about the
selected design
or object.

Quick
Access
Toolbar:
Buttons shown
here are always
visible.

Sequence View: Displays design
sequence by color and design.

Thread Palette: Displays the information about colors and thread of elements in the design. It also allows for color changing, adding and removing.
Click on the + or – to add or remove colors from the palette.

Designs View: Displays
designs and design folders.

Navigator
View:
Displays a box
around the
design and a
slider to zoom in
on the design.

Effects View: Displays outline and
fill effects available when design or
artwork is selected.

Rulers
Design
End
Point
(red)

Design
Start
Point
(green)

Open Design Tab(s): Multiple designs may be
open at any one time. The current design name
is designated with an X next to the name.
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LEARNING PRO-STITCHER DESIGNER
Online Videos & Tutorials

We encourage you to learn more about Pro-Stitcher Designer™ by watching the online videos found on www.ProStitcher.
com. There are also written tutorials to go along with the videos.
Videos and written tutorials are also available in the program by selecting the Help tab and clicking on the Tutorials button
on the ribbon.

FIND COMMONLY USED FEATURES
General instructions: To access the various Pro-Stitcher Designer functions, you will typically select one of the tabs
which displays a ribbon of buttons below the tabs. Further customization is available using right-click menus or the run,
transform, sequence view or effects windows along the right side of the screen.

To Do This

Select This Then Do This

Open a new design page

Home
tab

Choose New.

Open a design

Home
tab

Choose the Open button from the Ribbon, choose a design from the library,
and click Open.

Save a design

Home
tab

Choose the Save button from the Ribbon, give your design a title and choose
Save.

Close a design

File tab

Select Close from the drop-down menu or click on the X on the design page
tab.

Show or hide the grid,
stitches, artwork, start/
end points, interlocking
preview, quilting space,
realistic stitch view, notes
or backdrop

View
tab

Choose the items from the Ribbon you want to display or not.

Draw a Design

Tools
tab

Choose Pencil, Line, Curve, Bezier or Arc from the Draw tools. Click on the
design page and use the tools to draw.

Draw a Shape

Tools
tab

Choose Artwork, then select from the following to create simple closed
shapes: rectangle, ellipse, triangle, diamond, star, rounded (rectangle),
hexagon, leaf, heart, flower, and spiral.

Duplicate a Design

Tools
tab

Select the Duplicate button from the ribbon, the design is now attached to
your mouse, click to place the design where desired.

Load a Backdrop

Tools
tab

Select the Backdrop Tool, then select an image file and click Open to load
the image to your design page.

Open an Area

Home
tab

Select the Area Library button from the Ribbon, select an area from the
library to open it.

Rotate, flip vertical or
flip horizontal a single or
grouped design

Modify
tab

Choose the desired function from the Ribbon.

Resize a Design

Modify
tab

Select Transform, then click Maintain Aspect ratio in the transform window
if desired. Choose either width or height and adjust by typing in the desired
size. Click Apply to change the dimensions of the design on the design page.

Edit a design point

Shape
tool

Click on a point and right click for more editing options.

www.ProStitcher.com

		

01/2020

Pro-Stitcher Designer Quick Reference Guide

To Do This

Select This Then Do This

Swap the quilting start
and end points

Tools
tab

With the design selected, click on the Swap button.

Repeat designs in the
design page

Tools
tab

Select the Repeat button from the Ribbon. A Repeat window will appear
where you can select the number across and down, distance between
designs, flip options and offset options. A preview window shows your
selections. Click Apply then OK to load the new design on your design page.

Send a Design to
Pro-Stitcher

Home
tab

Save your design in HQV format first. Next, select the Send button from the
Ribbon. Your design will load in Pro-Stitcher Premium with your changes.

Undo or Redo a function

Home,
Tools,
Modify or
Preview
Tabs

Undo or redo any function by choosing the appropriate button from the
Ribbon.

HOME TAB RIBBON BUTTONS
ICON

FUNCTION
Undo

Select to reverse a previous action. The only limit to the number o times undo may
be used in sequence is when it reaches the point that the design was save, or a
blank page (if the design has not been saved). This function is visible on the ribbon
under the Home, Tools, Modify and Preview tabs. While a draw tool is active, use the
Backspace key to undo the last point.

Redo

Select to restore the undone action. Again, this is limited by the number of restores
since the last save of the file. This function is visible on the ribbon under the Home,
Tools, Modify and Preview tabs.

New

Select to open a new design page. The name of the file will default to “Design X”
where x is the next number of the new page opened in this session.

Save

Select to open a new design. A library will open. Select a design and click open to
load the design to your design page.

Open

Click to save the current design. If it is a new design that has not been saved, the
“save as” dialog box opens to allow input of the location, name and format of the
design. Note: to change the name or location of a previously saved file, select
File>Save As.

Print Preview

www.ProStitcher.com

DEFINITION

Select to access the Print Preview screen to print templates, color charts, etc. of the
design. See the print feature for optional settings.

Send

Send the current design to Pro-Stitcher Premium.

Area

Open the Area Library.
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TOOLS TAB RIBBON BUTTONS
ICON

FUNCTION

DEFINITION

Copy

Select to copy the selected (highlighted) object(s). The copied object(s) are
temporarily available on the “clip board” to be pasted to another location or another
design.

Cut

Select to remove the selected (highlighted) object(s). The cut object(s) are
temporarily available on the “clip board” to be pasted to another location or another
design.

Paste

Select to insert any copied or cut objects to a new location or design. Objects may
be pasted multiple times as long as they are on the “clip board”.

Delete

Select to delete the selected (highlighted) object(s).

Pencil

Click on the Pencil tool (or press letter P on keyboard) and draw by moving the
mouse. Release the mouse to pause drawing, click and move to continue. Mouse
right click to finish.

Line

Click from point to point for straight lines, right-click to finish.

Curve

Click from point to point for curved lines, mouse right click to finish. Only a few points
are needed for nice smooth curves. Fewer points make smoother curves.

Bezier

Mouse left click for straight lines, mouse left click and drag for curves, immediately
controlling the curve by moving the mouse in the desired direction. Pressing Ctrl on
your keyboard and then mouse left click and moving the anchor will create a cusp
point. One tool for all types of curves and lines. Mouse right click to finish.

Arc

Arcs are parts of circles. Mouse left click from point to point, three points for the first
arc, then only two for the following arcs. Mouse right click to finish.

Artwork

Select icon, then select the type of artwork to create: rectangle, ellipse, triangle,
diamond, star, rounded (rectangle), hexagon, leaf, heart, flower and spiral.

Close Outline

Before finishing an object by mouse right clicking, click on this button if your pattern
has to be a closed shape, so it can be filled with stitches.

Swap

When a design is selected, use this button for those times when you want to switch
the start and end points, such as when you rotate or flip a design and the start point
is now at the right side of the design.

Note

Notes on the Design Page are different from Copyright Notes. Notes on the Design
Page will NOT end up in any quilt format. The notes can be printed along with the
design; this function is useful for printable pantographs, to number patchwork pieces,
for class handouts, etc.

Text

Input text using selected fonts. Also, use instead of the select tool, to edit text as text
instead of objects.

Auto Digitizing

Duplicate

Repeat
www.ProStitcher.com

Wizard function to create a stitch file from artwork.
Select an object(s) or design, select the icon then click on the design screen while
holding down the left mouse button to drag and rotate a copy(s) of the selected
object.
With the object(s) selected, click the icon to display the repeat menu and determine
the number of repeats of the design both horizontally and vertically, with additional
parameters.
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Carousel

Select the design or object(s) to be placed in a wreath configuration. Specifics may
be adjusted in the Carousel Template dialog box.

Reflect

Select the design or object(s) to be placed in square configurations. Specifics may
be adjusted in the Reflect Template dialog box.

Echo Quilting

Repeat on Path

Select the design or object(s) to create echo stitching or a boundary around.
Specifics may be adjusted in the Echo Quilting dialog box.
Select a design or object(s) and click Design on Path. This allows placing designs on
a repeated path in a creative way.

Rays

Select a design or object(s) to add rays, as a continuous path, around a selected
closed shape. The shape must be a simple closed shape with not too many inside
curves and no backtracking. Specifics may be adjusted in the Rays dialog box.

Slice

Use to split an object into two or more objects. The object must be in artwork form.
Select the object with the shape feature, then left mouse click on one side of the
object and drag across to the other side. In the Sequence view window, right click on
the artwork item, and choose Break Apart. There are now two objects.

Backdrop Tool

Select this tool to open an image from your computer into the work area. While
selected, the image may be resized, scaled and a new horizon applied. Note: Only
one background is allowed per design.

Magic Wand

Used in conjunction with backdrop images, artwork images, etc. Select a draw
tool from the Ribbon, then select Magic Wand. Click on a closed shape area of the
loaded backdrop image and the Magic Wand will digitize the shape.

Batch Conversion

Used to create multiple file formats of the same design. When a design is ready to
be saved in all quilt formats, add a copyright note/designer name in the Notes field in
the property panel first. Then you can save in all supported quilt formats in one step.

MODIFY TAB RIBBON BUTTONS
ICON

FUNCTION

DEFINITION

Flip Horizontal

Select to mirror image the selected object(s) top to bottom.

Flip Vertical

Select to mirror image the selected object(s) left to right.

Rotate Left

Select to rotate the selected object(s) to the left 45 degrees. May be selected
multiple times. To rotate a precise number of degrees, left mouse click on the
triangle in the bottom right corner of the button and select Change Value. Enter a
specific value in the Change Value box.

Rotate Right

Select to rotate the selected object(s) to the right 45 degrees. May be selected
multiple times. To rotate a precise number of degrees, left mouse click on the
triangle in the bottom right corner of the button and select Change Value. Enter a
specific value in the Change Value box.

www.ProStitcher.com
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Transform

Crop

Left Align

Group

Use the Transform feature to manually rotate or resize an object(s) or design(s).
Select the object(s) or design(s) and then select the Transform button. Handles will
form around the object. Use your mouse or finger on the handles to resize. Use your
mouse to drag the design around the Design Page. Or use the mouse on the round
handle (above the upper right corner and below the lower left corner) to rotate the
design. Touch Transform to turn off the handles.
Crop is used to remove unwanted parts of a design. There must be two designs
opened in your design page which overlap and both must be in artwork format.
Select both designs, then click on the crop button. Only the sections of the first
loaded design which overlapped with the second design will remain.
Use the Align options to position the selected design(s) in relation to each other.
Choose from Left, Horiz, Center, Right, Center, Top, Vert., Center and Bottom. Your
last selection will be visible on the Align button until another is selected.
Groups two or more objects together. When selecting an object that belongs to a
group it will select all objects in that group.

Ungroup

Breaks apart grouped objects. When selecting grouped objects all the items will be
broken apart into individual objects and then can be selected separately.

To Front

Click to move the selected objects(s) to the top of the design which is the last item in
the stitching sequence.

To Back

Click to move the selected object(s) to the back of the design which is the first item
in the stitching sequence.

To Origin

To Grid

Select an object and click this button to center it on the 0,0 position of the rulers.

Select an object and click this button to center on the 0,0 position of the grid.

Trim

Select two simple closed shape objects in artwork format that are overlapping and
click this button to combine. The last design placed will be on top and the two
objects will be combined.

Weld

Select two simple closed shape objects in artwork format that are overlapping and
click this button to weld them together. The outline of the two shapes will become
one continuous shape.

Intersect

Select two simple closed shape objects in artwork format that are overlapping and
click this button to leave behind only the part of the objects that intersect.

Distribute Horizontal

Select multiple objects (3+), then click to allocate equal horizontal spacing between
them. The left and right margins will not extend further.

Distribute Vertical

www.ProStitcher.com

Select multiple objects (3+), then click to allocate equal vertical spacing between
them. The top and bottom margins will not expand further.
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PREVIEW TAB RIBBON BUTTONS
ICON

FUNCTION

DEFINITION

Convert to Stitches

Select an object(s) and click to convert to stitches.

Convert to Artwork

Select a design(s) and click to convert to artwork.

Stitchout

Select to display a virtual sew-out of the design. When this button is selected,
manipulate the arrow keys and slider bar to view the stitching sequence of a design
before committing it to fabric.

Optimize Entry / Exit

Click to improve the entry and exit points of sequential objects for the closest point
connection. Reduces jumps.

VIEW TAB RIBBON BUTTONS
ICON

FUNCTION
Grid

Stitches

Artworks

DEFINITION
Select the button to turn on or off the grid on the design screen.
Show or hide stitches. If stitches off/hidden, only the shape of the object is displayed.

If the button is highlighted, click to dismiss the artwork, notes, etc. from the display
area. Click again to turn on the button and the artwork, notes, etc.

Start / End

Select the button to show or hide the start and end points of a design.

Interlocking

Select the button to show or hide interlocking preview. This features allows you
to see if your design repeats well while you are drawing it. It’s easy to see where
details need to added to prevent gaps in an overall design. This view is available in
artwork or stitch objects.

Quilting Space

Select to view the quilting space. Adjust the size of your quilting space under
Settings Tab>General Options>Machine Tab.

Realistic

Click on the button to toggle back and forth between regular view and a more
realistic (three dimensional) representation of the design.

Notes

Folders

Backdrop

Zoom to Fit
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Click on the button to turn on or off notes on the Design Page. These are different
from Copyright Notes. Notes on the Design Page will NOT end up in any quilt format.
The notes can be printed along with the design; this function is useful for printable
pantographs, to number patchwork pieces, for class handouts etc.
Select the button to open a drop down menu which allows you to open designs,
images or library files from your computer’s hard drive.
Select the button to turn on and off the backdrop in your design page.
Use this set of buttons to quickly zoom to fit your design in the page, see your design
at 1:1 or zoom to your selection by clicking on each separate button.
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SETTINGS TAB RIBBON BUTTONS
ICON

FUNCTION

DEFINITION

General Options

Use this to set the defaults for thread palette, language, Autosave, Quilting Space,
Grid options and View Options.

HELP TAB RIBBON BUTTONS
ICON

FUNCTION
Tutorials

Select to open a link to online video and written tutorials for a computer or tablet that
is connected to the internet.

About

Select this button to open an information box with program info, version number
and copyright info. A direct link to the prostitcher.com website is also included for a
computer or tablet that is connected to the internet.

My Home

Registration

Updates

www.ProStitcher.com

DEFINITION

Select this button to open the home screen.
Select this button to display the activation dialog. This is where you register and
unregister your software.
Select this button to check for updates. If you are connected to the internet, the
software will automatically check. If you are on a tablet without internet access,
insert USB with the saved update into the appropriate drive, then click on this button
to run the update.
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Pro-Stitcher Designer
Keyboard Shortcuts
File Tab

Selection

New Design Page 		
Ctrl + N
Open Design			
Ctrl + O
Save				Ctrl + S
Print				Ctrl + P

Select				Q
Shape 		
		
E
Zoom 				
Z
Pan 				M
Ruler 				R

Edit Tools
Undo 				
Ctrl + Z
Redo 				
Ctrl + Y
Cut Selection to Clipboard
Ctrl + X
Copy Selection 			
Ctrl + C
Paste Selection			
Ctrl + V
Duplicate Selection 		
Ctrl + D
Delete				DEL
Select All			
Ctrl + A
Nudge a Selection		
Ctrl + Arrow Keys
Insert				Ctrl + T

View Tools
Zoom in/out on position
of mouse pointer		
Scroll design Page		
Zoom out 			
Zoom in				
Zoom to fit 			
Show/Hide Stitches		
Realistic Stitches View		
Zoom 1:1			
Zoom to Selection		
Show/Hide Backdrop		
Snap to Grid			
Snap to Guideline		
Snap to Anchor Points		

Arrange
Group Selection			
Ungroup Selection 		
Move to Front			
Move to Back			

Ctrl + G
Ctrl + U
Ctrl + Shift + ]
Ctrl + Shift +[

Alt + Scroll Wheel
Arrow Keys
+
Space Bar
Ctrl + S
Ctrl + 3
/
.
Ctrl + B
Ctrl + 7
Ctrl + 8
Ctrl + 9

Tools: While Drawing
Pencil 				P
Line 				L
Curve 			
C
Bezier 		
		
B
Arc 				A
Undo Last Point			
Backspace
Snap to Anchor Points		
S/

Tools: While Using Shape Tool
Move from one point to
the next			
Delete a Selected Point		
Artwork				

www.ProStitcher.com

Ctrl + Arrow Keys
DEL
0
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